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1 Contact NECS
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SOFTWARE FOR FOOD DISTRIBUTORS

¢ Please visit our website at www.necs.com to learn about our other add-on modules, products
and services.

e Contact our NECS Sales Department at sales@necs.com for more information.

e Contact the Tech Support Department at tech@necs.com for assistance.

For information about current NECS software training classes use this link:
necs.com/training.php

NECS, Inc.
322 East Main Street, Third Floor
Branford, CT 06405

Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST

Toll Free: 800.766.6327 (NECS) Phone: 475.221.8200 Fax: 203.208.0889
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License Agreement

NECS entrée V4 SQL and RELATED ADD-ON MODULES
SOFTWARE END USER LICENSE AGREEMENT

THIS SOFTWARE END USER LICENSE AGREEMENT (“THIS AGREEMENT’) IS A LEGAL AND BINDING
AGREEMENT BETWEEN YOUR COMPANY (LICENSEE) AND NECS, INC., A CONNECTICUT "CLASS C"
CORPORATION WITH ITS OFFICE LOCATED AT 322 EAST MAIN STREET, 3RD FLOOR, BRANFORD, CT
06405 (NECS).

THIS AGREEMENT GIVES YOU THE RIGHT TO USE entrée V4 SQL (THE “SOFTWARE"). BY
DOWNLOADING, INSTALLING OR OTHERWISE USING THE SOFTWARE, YOU ACCEPT AND AGREE TO
BE BOUND BY ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE
TO THESE TERMS AND CONDITIONS, DO NOT DOWNLOAD, INSTALL OR OTHERWISE USE THE
SOFTWARE.

1. Grant of License. This Agreement grants you a non-exclusive, nontransferable, non-sub licensable license
to install and use one (1) copy of the specified version of the Software to be installed on your server and
designated workstations based upon the user license count purchased.

2. Ownership. The Software is licensed and not sold to you. This Agreement grants you only the right to use
the Software, but you do not acquire any rights, express or implied, in the Software other than those
specified in this Agreement. NECS retains all rights, title, and ownership to the Software, including all
patents, copyrights, trade secrets, and other intellectual property rights incorporated therein. The Software
is protected by copyright laws, international treaty provisions, and other intellectual property laws.
Therefore, other than as expressly set forth herein, you may not copy the Software without prior written
authorization of NECS, except that you may make one (1) copy of the Software for your back-up purposes
only. You may not edit any printed or electronic materials accompanying the Software.

3. License Restrictions. Except as provided otherwise herein, you shall not rent, lease, sublicense, sell,
assign, loan, or otherwise transfer the Software. You shall not, and you shall not permit any third party, to
reverse engineer, decompile, or disassemble the Software. You may not remove or destroy any product
identification, copyright notices, or other proprietary markings or restrictions from the Software. You may
not modify or adapt the Software, merge the Software into another program or create derivative works based
upon the Software. You may not copy the Software onto a greater number of workstations than your
purchased user license count.

4. Termination. This Agreement shall be effective upon installation or first use of the Software and shall
terminate (i) at the discretion of NECS, due to your failure to comply with any term of this Agreement; (i)
failure to pay Software Maintenance fees; or (iii) upon destruction of all copies of the Software and related
materials provided to you by NECS hereunder. NECS rights and your obligations shall sunive the
termination of this Agreement.

5. Upgrades. NECS may, at its sole option, make upgrades to the Software available by general posting on a
website or by any other means or methods. Such upgrades may be made available pursuant to the terms of
this Agreement or the release of such upgrades to you may be subject to your acceptance of another
agreement.

6. Support Services. Your license for the Software does not include any technical or other support ("Support
Senices") for the Software. Support Senices are provided through a separate, paid agreement known as the
"NECS Software Maintenance Agreement". Your continued use of the Software requires that you both
maintain a current Software Maintenance Agreement with NECS and that you be current on the scheduled
payments which are specified in that Agreement. Per Section 4 abowe, failure to comply with this
requirement can result in termination of your license to use the Software.
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7. Limited Software Warranty. The Software, Software maintenance senices and Software updates, are
provided "AS IS", without warranty of any kind, expressed or implied, including but not limited to, the
implied warranties of merchantability, or fitness for a particular purpose. NECS does not warrant that the
functions contained in this Software will be uninterrupted or error-free. The entire risk as to the quality and
performance of the Software is with the Licensee. SHOULD THE SOFTWARE PROVIDED BE DEFECTIVE,
YOU (NOT NECS) ASSUME THE ENTIRE COST OF ALL-NECESSARY SERVICING, REPAIR, OR
CORRECTION. WHILE EVERY PRECAUTION HAS BEEN TAKEN IN THE PREPARATION OF THIS
SOFTWARE, NECS ASSUMES NO RESPONSIBILITY FOR ERRORS OR OMISSIONS, OR FOR
DAMAGES RESULTING FROM ITS USE OR MISUSE. IN NO EVENT SHALL NECS BE LIABLE FOR ANY
LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE CAUSED OR ALLEGED TO HAVE BEEN
CAUSED DIRECTLY OR INDIRECTLY BY THIS SOFTWARE. IN NO EVENT WILL NECS BE LIABLE TO
YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE
EVEN IF NECS AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.

8. Notwithstanding the foregoing, NECS IS NOT LIABLE TO LICENSEE FOR ANY DAMAGES, INCLUDING
COMPENSATORY, SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES,
CONNECTED WITH OR RESULTING FROM THIS LICENSE AGREEMENT OR LICENSEE'S USE OF THIS
SOFTWARE.

9. Licensee agrees to defend and indemnify NECS and hold NECS harmless from all claims, losses, damages,
complaints, or expenses connected with or resulting from Licensee's business operations.

10. Refund Policy. We have a no refund policy on the Software and related software modules. We do this
because we offer free, fully functional demonstration versions which allow you to use the Software before
your decision to purchase. These demonstration versions allow you to trial test the Software risk-free. Also
our software is provided without any copy restrictions, meaning that once it is installed, NECS has no
means to ensure it is no longer being used.

11. Governing law. This License Agreement is governed by the law of the State of Connecticut applicable to
Connecticut contracts.

This document covers system features of entrée V4 SQL. No part of this document may be reproduced in any form or
by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage

and retrieval systems - without the written permission of NECS, Inc.

Updated September 2016

© 2013 NECS, Inc. All Rights Resened.
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Leqgal Notices

Information in this document is subject to change without notice. Complying with all applicable copyright laws
is the responsibility of the end user. Without limiting the rights under copyright, no part of this document may
be reproduced without the express written consent of NECS, Inc.

entrée and NECS Food Distributing System are trademarks of NECS, Inc. in the United States and/or other
countries. NECS, Inc. may have patents, patent applications, trademarks, or copyrights covering subject
matter in this document. Except as expressly provided in any written license agreement from NECS, the
furnishing of this document does not give you any license to these patents, trademarks, or copyrights.

Microsoft, Windows, Windows NT, Windows 2000, Windows ME, Windows XP, Windows 7, Windows 8,
Windows Vista and Internet Explorer are either registered trademarks or trademarks of the Microsoft
Corporation in the United States and/or other countries.

Intuit and QuickBooks are trademarks and senice marks of Intuit Inc., registered in the United States and
other countries.

©2010 - 2018 All Rights Reserved.

SOFTWARE FOR

v
NeCS [entree

Please \isit our website at www.necs.com to learn about our other add-on modules, products and senices.
Contact our NECS Sales Department at 800.766.6327 or email sales@necs.com for more information.

NECS, Inc. 322 East Main Street 3rd Floor Branford, CT 06405
Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST
Toll Free: 800.766.6327 (NECS)
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entrée.QB Introduction

Link entrée to QuickBooks and Complete Your Accounting Connection

entrée.QB is an add-on module that allows distributors to port GL (General Ledger) and AP (Accounts
Payable) related data from the entrée application into QuickBooks. The unique design of entrée.QB as a
stand-alone application allows all of the users in the entrée system to work as normal, without any of the
security, network or licensing issues that can occur with a direct link into the QuickBooks application.

Tasks Performed with entrée.OB
» Post pending AR Journal Entries from entrée into QuickBooks selectively or as a single batch.

» Post pending Purchase Order Payables from entrée into QuickBooks selectively or as a single batch.
= Allow for synchronization of the entrée and QuickBooks vendor files.
= Allow for synchronization of the entrée and QuickBooks GL account files.

Operating entrée.0QB
= QOperators of the entrée.QB application will typically be the same person or people that would be
responsible for operating QuickBooks on a day to day basis.
= entrée.QB must be installed on a workstation that has both the entrée application and QuickBooks
Client installed.

» |n order for entrée.QB to communicate with QuickBooks, QuickBooks must be running and the
QuickBooks company file to post to must be open.

If you would like more information related to pricing or a specific quote for your company’s needs, please
contact the NECS Sales by email sales@necs.com or call 800.766.6327 (NECS). Please \isit our website at
necs.com to learn about our other add-on modules, products and senices.



http://necs.com/qb/
http://necs.com/index.php
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entrée.QB Product Features

The NECS entrée.QB software allows you to easily link your entrée system with QuickBooks*. This module
is especially valuable if your company’s accounting staff is trained and proficient in QuickBooks*, and you want
to continue to use it for General Ledger and Accounts Payable purposes. No longer will there be any kind of
double entry needed, as entrée.QB automates the communications between both systems.

The unique design of entrée.QB as a stand-alone application allows all of the users in the entrée system to
work as normal, without any of the security, network or licensing issues that can occur with a direct link into
the QuickBooks application.

General Ledger Features
e Can optionally import your QuickBooks* Chart of Accounts into entrée V3 or entrée V4 SQL.

Can optionally export your entrée Chart of Accounts into QuickBooks*.

Using customer grouping, can release entrée accounting data into different QuickBooks* companies.
Released data into QuickBooks* can be in a “Summary” format (one entry per general ledger account).
Released data into QuickBooks* can be in a “Detail” format (each sales and cash receipt transaction posted
as a separate journal entry).

Accounts Payable Features
Link entrée vendors to QuickBooks* vendors.

Can optionally import your QuickBooks* vendors into entrée.
Can optionally export your entrée vendors into QuickBooks*.
Create a “QuickBooks* Bill” from an entrée received purchase order.

Import/Export & Synchronize GL Accounts

The entrée.QB software module will synchronize GL (General Ledger) Accounts between entrée and
QuickBooks to ensure the accuracy of your Chart of Accounts. Typically GL accounts are pulled into entrée
from QuickBooks using the Import GL Accounts utility. However as part of the initial setup of entrée.QB,
operators are allowed to export an existing entrée GL account file into QuickBooks.
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Override Accounts

Chart of Account codes which owerride the normal codes can be assigned to your inventory items and your
vendors in the entrée system. To ensure that both entrée and QuickBooks function together properly, you will
need to verify these codes when you first start using entrée.QB.

¢ Inventory items can be assigned owerride Sales and Cost of Goods Sold GL accounts defined on the
Cost/Price tab of Inventory File Maintenance in entrée.

ﬁ Special Pricing | Sale Pricing | Future Pricing | Break Pricing m fizc 1 I

[rrventory IEDSL"' PfiCE‘ Wendor [ Purchazing | Promobions

Cost/Price Information

Processing Trim Costs

F Trim Yield % Broken Case Upcharge
Trim Yield Cost Group Code |:|
Trim Credit Matrix Code | |

Cost Mark-Up 0.0000) @$ © % Retail Price

Base Unit Cost

Real Unit Cost
Freight Rate

Landed Cost

= |2 |e
(=] ] o
[5;] = n
= =] ]
=] =] =]

Min. Selling Price | U-EEUU| | U-Ul| Bé 0% || Quick Price Change ||
Market Cost G/l Cost of Sales Account :I‘@,

G/L Sales Account |:| ‘@,

o ”ﬁ| Click the Search button to open the GL Account Search dialog to find the correct account.

Vendors
Vendors can be assigned override defaults using Def Expense Account and/or Def Control Account fields in the
Vendor tab GL/Account tab in Vendor File Maintenance in entrée.

These expense and control = =
accounts will be used by PO Options [ 2 GLMccountl BE Monetary Exchan
default when creating a

payable to export into T | ous+4 ||

QuickBooks after closing a T —_—

purchase order in entrée. DefBxp Acct :Ilﬁl Def Ctrl Acct @I
1099 Info -

Interest
Miscellaneous
Other Income
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Import / Export & Synchronize Vendors

Your entrée vendors must be linked or exported into QuickBooks before any purchase order payables can be
posted into QuickBooks. Typically vendor accounts in entrée are linked into the corresponding vendor
accounts in QuickBooks using the Link Vendors utility.

As part of the initial setup of entrée.QB, operators are allowed to export any vendors in entrée into
QuickBooks or import QuickBooks vendors into entrée.

| Export Vendors

|Export? |entrée ID  Company Ext, Acct, &  [External Company
| % ADMAD ARTHONY DAMDS HIGHLAMD CO. ADH1D ARTHONY DAVIDE HIGHLAMD S0,

-
7
-
|
el
@
il
=
@
il
|
&
i
|
@
il
|
@

*

]
=
lal
=
H
B
]
—
=
-
H
|
]
=
[ ]
—

APCID

BRY1D
CAT1D
CFCA0
CMC1D
OFID
EPHO
FFT10
GEX10
GFD10
GFID
GFS10
GFWMD
GMTID
HEID
M0
JFCA0
KCE10

ARC FRIME CUTS

BILLY'S PAPER SUPPLY
BRYE0N CHICKEM FARMS
CATCH THIS

CENTURY FOOD COR®,
CIRCLE MEAT CO., INC.
DEVRQ FOOOS NG,

EAGLE PACKERE, INC
FARMFRESH TOMATOES
GOURMET EXFRESS

GREAT FOODS

GLINTER FARME, INC.
GRAMDE FOOD SERVICE
GARDEN FRESH WHOLESALE
GERBER MEATS

HEMRY BROTHERS. INC.
BTERMATIONAL MEATE, INC.
JFFY CHEEZE CO, INC.

K& G BUFFLY WAREHQUISE

| @ semcan |

APCA0

AEC PRIME CUTS
BILLY'S PAFER SUFFLY

CIRCLE MEAT CO., INC.
DEVRD FOQDS INC.

EAGLE PACKERS, INC
FARMFRESH TCMATCES
GOURMET EXFRESS

GREAT FORDS

GUNTER FARME, INC.
GRANDE FOOD SERVICE
GARDEN FRESH WHOLESALE
GERBER MEATS

HENRY BROTHERS, MG
INTERSMATIOMAL MEATS, IMNC
JIFFY CHEESE CO., IMC.

K& C 3UPPLY WaREHDLIZE

| =% Export

[=! S-wliu:l Hona |

Marison Distrioution |
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Post Payables to QuickBooks

entrée offers the ability to create a payable or vendor bill at the time a purchase order is received in the entrée
system. After receiving product from a purchase order and you have received the vendors inwice, you will be
prompted to close the purchase order and create a payable in QuickBooks.

The Balance To Distribute field will contain the remaining amount of the payable that needs to be distributed.
This value cannot be edited directly, but is derived using the value in the Amount field less the total of the
distributions that have been applied in the distribution grid.

This field will be highlight in green when the balance reaches 0.00, otherwise it will be highlighted in red. By
default the total of the purchase order (or the Amount field if manually changed) is posted as a distribution to
the vendors default expense account.

o Post payable to external accounting... = =
Vendor Information
Account Information
Vendor #:
COAST TO COAST Terms:
Due Days: 0
Def.Cirl Acct:
Phone:  347/240-6273
Fan: ! - Def. Exp. Acct:
Payable
Invoice =: 123 Invoice Date: 07/22/14  » Amount: 3.86
)
PO Number: DueDate: |07/22/14 w Cirl Acct: |20000 4
Reference: Balance To Distribute 0.00
Distributions:
Account Account Description Amount Reference ]
a0 Sales Account 1 3.86
W
Add Delete
Cancel
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Export Journal Entries

As you use the main entrée application and wish to export your account postings to QuickBooks, you will use
the “Release to GL" feature. This will save all account postings to a holding file. entrée.QB then uses the data
contained in the holding file to push the journal entries into QuickBooks. To use this feature, you must have
first synchronized the entrée and QuickBooks GL account files using the Import and/or Export GL Accounts
utility.

¥ enbréeQE Accounti
File Post Hep

Export Journal Entries
|Export? Batch Trems. Date | Trans. Type = Imvoice # Cust. =

003 di262010  Bales 100002 EAS10
002 4126/2010  Sales 100003 D0
0oz A4268/2010  Sales 100004 GYR10
003 4262010 Sales 100005 ExP10
003 ARGE010 Sales 0008 KIN10
na3 472602010 Sales 10007 FERAD
no3 di2602010  Sales 10000E JOEID
no3 42602010 Sales 10000e KIMAD
003 412802010  Sales 100010 MoL10
002 4282010 Sales 100011 STH10

ARE200 Sales 1060012 LEGAD

4262010 Sales 100043 JOHID
na3 Ai2602010  Sales 100014 RMIKED
003 di2602010  Sales 100015 KIMAD
po3 4262010 Bales 100016 TOME0
003 412802010 Sales 100017 SPA1D
0oz A26/2010  Sales 100012 S0OK10
003 AREE0N0 Sales 100019 TAT10
na3 42602010 Sales 10020 DEVID
na3 4260210 Sales 100021 GLEID

Arroants Recesmbln
Inventary (Primary)

Fuel Surchargs

Sales (Primary)

Cost of Goods (Primany)

Ao oo oA

=

A 3 D W XD A OO CO @D™I WO

Selnct Al || Select None [ Esportl

Madisan Distibuticn |

entrée.QB allows for journal entries to be posted into QuickBooks in one of two methods:
¢ Summary mode will post an entire entrée release batch as a single journal entry.

e Detail mode will post a journal entry for each Sales transaction (inwice/credit memo) and cash receipt
within the entrée release batch.

The detailed posting provides much greater traceability in the QuickBooks general ledger. Sometimes food
distributors using QuickBooks will have more than one company defined. entrée.QB allows you to export
journal entries to different companies you may have defined in QuickBooks.

In order to accomplish this, you can classify ®mm (Cystomer File Maintenance
customers into different QuickBooks
companies by using the “Customer Misc. Cust. Number [MAD101 - [\ 2 ,| Price Level |:|

Code” in Customer File Maintenance in the
main entrée system.

Company IMADISON FUN FOODS |

Address 209 BOSTON POST ROAD |
When exporting journal entries, specify
the QuickBooks company and also the | |
Customer Misc. Code, and only the MADISON | 06443 |
journal entries that are associated with _ -
that customer code will be posted. Terdtory | | | Misc.Code | || Country

Industry REST - Inactive Potentia
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System Requirements

The entrée.QB add-on module requires:
e entrée V3 or entrée V4 SQL.

e QuickBooks desktop versions 2002 or later.

» entrée.QB for entrée V3 and entrée V4 SQL has been updated to be compatible with QuickBooks
version 2013 and higher for the Professional, Premier, and Enterprise Editions.

The entrée.QB software must be installed on a workstation that has both the entrée application and the
QuickBooks Client installed. The unique design of entrée.QB as a stand-alone application allows all of the
users in the entrée system to work as normal, without any of the security, network or licensing issues that
can occur with a direct link into the QuickBooks application.

Minimum hardware requirements for entrée version 4 SOL

To improve system performance for larger installations, a faster processor as well as a going to Quad Core
technology on the sener is recommended. Workstation performance can be increased by a faster processor
and more RAM memory.

Server Requirements
e Windows 2008 Sener / Windows 2012 Server (including Standard and Server Essentials).

o Dual Core processor. Note that the Sybase Advantage Database Server supports multiple processors on
Windows. It is multi-threaded and will perform each user request database operation concurrently or in
parallel if multiple processors are present.

o Intel Xeon 2.4 GHz or greater
e 16GB RAM
e Windows 64-Bit

e 500GB hard drive, 1TB recommended. 3TB recommended if using entrée.DOC, entrée.PEN and hawe a
high wvolume of inwoice, etc. images that are stored (more than 1,000 images/day to provide sufficient space
for at least 7 years).

Workstation Requirements
Windows 7 / Windows 8

Intel 15 or greater

4GB RAM

1360 x 768 minimum monitor resolution
60GB hard drive

Remote Desktop requirements

Minimum Terminal Server requirements (for up to 10 workstations):
e Dual core Xeon processor 2.2GHz +

e 4 GB Ram

e Windows 2003 Server R2

Recommended Terminal Server requirements (for up to 10 workstations):

e Quad core Xeon processor 2.33GHz +
e 8 GB Ram
o Windows 2008 Sener 64 Bit

|II¥

Note
The entrée data files should not be installed on the terminal server. Instead they should live on a

separate file server.
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Getting Started

entrée Versions

With the release of entrée version 4 SQL in 2014 and the major differences between the menus
and screens in both entrée versions 3 and 4 we have included instructions for using both versions
of entrée in this guide.

To differentiate topics for each major version of entrée you will see color coded gntrée V3 or
entrée V4 SQL headers in the impacted topics to direct you to the correct information for your
system.

NECS entrée KnowledgeBase Links

e entrée V4 SOL KnowledgeBase

¢ entrée V3 KnowledgeBase

4 INote . , L . . . .
= To install entrée.QB for the first time use the instructions in the Installing

entrée.QB chapter in this guide.

entrée.QB Online Support & Version Updates

When you are notified that the entrée.QB software has been updated to obtain the new version release you
must login to our website to download it.

1. Go to necs.com and click the Support menu and select Customer Login. Enter your assigned Username
and Password and access the support web page.

7 . ) P "
B8, sortware for Food Distributors Toll Free: 800.766.6327 | Local: 203.245.3999 ‘e

Home About Products Support Blog Partners Contact

c u sto m e r Logi n Top Notch Support from NECS, Inc.

If you are an existing customer of NECS, and wish to download the |atest version of your entrée application and have access to other customer

support options, please log in below. Other customer support options you will have access to include:
= | atest Feature Flash documents describing how to use new and enhanced features.
= Product Guides providing access to all our printed information including manuals and product brochures.

+ Online and fully searchable Knowledgebase's full of information regarding entrée and its modules.

» Modifications Catalog which describes specialty enhancements to entrée which may be a good fit for your needs.

Username:
frances
Password:
. This area is reserved for customers active on entrée Software Maintenance. Software Maintenance customers enjoy the following benefits:
» Unlimited phone technical support Monday-Friday, 8:30AM to 5:30PM eastern standard time. A 24/7/365 option is also available.
s Minor version entrée software updates available for immediate download.

+ Technical support requests that are emailed to all NECS technicians for fast response.
* Remote support assistance which allows an NECS technician to login to your system.

* Automated email notifications for new feature availability and other important correspondence.

About The Customer Support Web Page
Once logged into the Customer Support web page you can select any software product from the Products
menu on the left to view the current software updates.



http://www.necs.com/eV4SQL_KB/
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You can view the entrée.QB user guide, knowledgebases and other support documents for entrée products in
the Customer Support web page.

In the lower left corner click of the Customer Support web page you can click the Download and review the
NECS 2014 Software Maintenance Agreement to review the latest terms and prices.

2. Select entrée.QB in the Products menu on the left. This will open the page with the latest entrée.QB
software for download. This web page will be used to update your initial installation of the software when new
versions are released

g : . ] |
2 « & . Software for Food Distributors Toll Free: 800.766.6327 | Local: 203.245.3999 g T ] b

Home About Products Support Blog Partners Contact

[ SOFTWARE FOR g V/ R
NECS | entrée

customer support Top Notch Support from NECS, Inc.

Welcome! You are logged inas: NECS, Inc (frances) Logout
_ ‘ Software Update Downloads ” Open Support Ticket ” Remote Assistance " entrée V3 Support Files
> entrée V4

entrée.QB Software Updates

> entréeV3 Release Date Version Description Release Notes File Name Size
[ 1010712011 11.0a General Update @ README TXT Update exe 8MB

N amdeialE

About Release Notes

The Release Notes column contains the README.TXT link. Click the link to review the updates and
modifications that are included in the current software version.

3. Click the green down arrow to download the entrée.QB software version update to your computer.

4. Then double-click the downloaded software module and run the update process.
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6.1

Installing entrée.QB
Notes of caution before you begin the entrée.QB installation process:

entrée.QB must be installed on a workstation that already has a working copy of entrée installed and
configured on it. The data path settings setup and maintained by entrée are shared by entrée.QB.
This point is critical and failure to adhere to it will result in an error message being displayed when
attempting to start entrée.QB.

QuickBooks software should already be on the computer that entrée.QB will be installed on.

Before installing and using entrée.QB, please be sure that the numbers from the "Release to GL" in
entrée are in balance.

entrée.QB should not be run until all the configuration changes in this chapter have been
implemented.

E LBE QB-specific configuration changes are system-level changes that will only need to be done
once for any given installation of entrée. (A possible exception would be the changes to a given user's
entrée User Account.) So if you are installing entrée.QB on a second computer everything may already be
configured in entrée to run entrée.QB immediately.

E Hot Tip! Itisrecommended that you begin using entrée.QB at the start of a new period.

Follow these steps to install the entrée.QB add-on module the first time.

Insert your entrée.QB CD into your computer CD drive.

2. The entrée.QB Installation wizard will begin.

entrée_(JB Installation

Initializing Wisze Installation Wizard.__

Note
E If the entrée.QB Installation wizard does not run automatically follow these steps:

= Go to the Windows toolbar at the bottom of your computer screen click on Start > My Computer

= Find the CD drive containing the entrée.QB install disk.
= Double click the CD drive to view the files on the CD.

= Find the Setup.exe file and double click it to begin the entrée.QB Installation wizard.
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3. The Welcome dialog box will display, click Next.

£ Welcome

program will inztall entrée. 0B on your computer.

g YWelcome to the entrée QB Setup program. This
g

[t iz strongly recommended that vou exit all Windows programs
before running thiz Setup Program.

Click Cancel to quit Setup and close any programs you have
running. Click Mext to continue with the Setup program .

WARMIMG: Thig program iz protected by copyright law and
international treaties.

[Inautharized repraduction ar digtribution af this prograrm, ar any
portion of it, may result in severe civil and criminal penalties,
and will be prozecuted ta the maximun extent possible under
g,

4. The Warranty dialog box will display, click Yes to accept the terms.

#2 Limited Warranty

Pleaze read the following warranty statement, Uze the scroll
bar to view the rest of thiz document.

LIMITED WwWARRANTY

MECS entrée. QB [tm) software and zoftware maintenance iz
provided “A5 15", without warranty of any kind, either
exprezzed or implied, including but not limited to, the implied
warrantiez of merchantability, ar fitheszs for a particular
purpoze, Mew England Computer Services, Inc. does not
waarrant that the functions contained in this software will be
uninterrupted ar error-free. The entire rizk az to the quality
and performance of the saftware iz with the uzer. Should the
software provided be defective, you [hot Mew England
Computer Services, Inc.] azsume the entire cast af all
NECESSAry SEMVICInG, IEpair, of correction,

Do you accept all the termg of the warranty? If 2o, click on the
Y'es puzh buttan, |F pou zelect Mo, Setup will cloge.
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5. The Choose Destination Location dialog box will display.

6. To install entrée.QB in the default folder click Next. Or you can click Browse to select a different
location.

Note
|§ NECS recommends that you choose the default folder location.

¥2 Choose Destination Location

Setup will inztall entrée (B in the following folder.

Toinstall into a different folder, click Browse, and select
another folder.

'ou zan chooze nat bo install entrée QB by clicking Cancel to
exit Setup.

Destination Folder

C:%Program Filez\MECShentrée OB Browee. ..

7. The Select Program Manager Group dialog box will display.

' Select Program Manager Group

Enter the name of the Program Manager group to add
entrée. 0B iconz oo

INECS\entrée. 0B

Aocessoles

Adrainiztrative Tools

Adobe

Adobe Maszter Collection C54
AVGE Free 8.5 _
Camtazia Studio B

CWSHT

Drivize,

Games
GIGABYTE
Goagle Chrome

3

[ £

v Add“entrée OB icon to desktop

¢ Back Cancel
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8. To put an icon on your desktop, check the
box for Add “entrée.QB” icon to desktop.

9. To select the default group click Next or select a group from the list.
10. The Start Installation dialog box will display click Next.

#2 Start Installation

Yiou are now ready to install entrée. GB.

Press the Mest button to begin the installation or the Back
button to reenter the inztallation information.

Cancel

11. Once installation has begun the Installing progress box will display.

Installing

o
Current File

Copuing entrée QB Application:
C:ACAMECShentrée QBYnecs eaexe

Al Files

Time Remaining 0 minutes 0 seconds

| oo |

23
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12. When the installation is done the Installation Complete dialog box will display. Click Finish.

¥ Installation Complete

entrée. B haz been successfully installed.

Prezs the Firizh buttan ta et thiz installation.

[MPORTAMT: Before running entrée. OB you MUST make
adjuztmentz to both QuickBooks as well az entrée. Please refer
to pour entrée. B manual for mare infarmation.

13. Now continue to the next section of this chapter Setting up QuickBooks for entrée.

All the sections in this chapter must be completed to ensure that entrée and QuickBooks are ready for
the synchronization process to follow.
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6.2

Setting up QuickBooks for entrée
GL Accounts must use account numbers to be compatible with entrée.

1.

2.

6.

7.

Note
@ The process above will have to be done for every QuickBooks company file that

From the main menu select Edit > Preferences

In the menu bar on the left, select Accounting

Select the Company Preferences tab at the top of the dialog

Make sure you check "Use account numbers".

Make sure you check "Require accounts".

Click OK.

entrée will be interfacing with.

| | Sl Sales & Customers

Il Accounting

Start your QuickBooks application and open the company file that will be interfacing with entrée.

K
& cheding

A5 Deskiop View

Ky Finance Charge

i General

4l rtecrated Applications
' Items & Imventory

w" Jobs B Estmates

15 Multiple Currendies
q Payroll & Employees
& Reminders

b Reports & Graphs

|z Sahes Tax

E Send Forms

(& service Connection
@ Speliing
[ Tax: 1099

A Time & Expenses

| Prompt to assign dasses
' Aytomatically assign general journal entry number

/] Warn when posting a fransaction to Retained Earnings
Date \Warnings

— !
] Wam if transactions are |90 | day(s) in the past

7] Warn if transactions are |30 | day(s) in the future

Cloging Date
Date through which books are dosed: (not set)

Set Date/Password

25
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Setting up entrée for QuickBooks

This section will provide an oveniew of what needs to be configured in entrée version 3 or entrée version 4
SQL, prior to running entrée.QB for the first time.

<" INote _— : . ;
= Before beginning this update process all users must exit the entrée system

so these steps can be completed.

First Update the entrée Accounting System
1. Login to your entrée system and do the steps for your version:

entrée V3 use menu path: System > Preferences > General Tab.

entrée V4 SQL Go to the System ribbon menu > System Preferences > General Tab.

2. Go to the Accounting System section in the System Version drop down menu select Linked
Accounting.

entrée V3 use menu path: System > Preferences > General Tab

i — B!
7 System Preferences l = —

Perzonal Settings ] Compaty lrvoice Headings ] Email Setup ] Return Codez l Comment Fonts ] Halidays ] entree DOT ]

General l Documents l System Options ] Frinters l [rata Files ] Pricing Setup ] GL Accounts ] Scralling Meszage ]
Company Infarmation I Delivery .-’-'xddress] Miscellanenus] Accounting System
System Yersion |entrée ﬂ

Compary  |MADISON DISTRIBUTORS, INC.

Address 1 |1 68 Boston Post Road AP Release & WisionPoirt
Pro Series
Address 2 | AP Link Compary  [FRealWorld
Fro Series 32
Lty |M.-’-‘-.DI5EIN 5L Link Caompany

Linked Accounting

State lF ZIF IW Country Code I_ “Vear End |DECEIT||:IE[ ﬂ
Contact  |FRANK CAPRIO
e m Fa Im Bounced Check Fee lﬂ
Fuel Surcharge IW
e Auto Logoff Delay [minutes] 1

Catchweight +/- percent 0.00 |

w Ok . Cancel
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entrée V4 SQL Go to the System ribbon menu > System Preferences > General Tab

- m-.
System Preferences I 73 ]

| Personal Settings I Company Invoice Headings I Email Setup | Return Codes I Comment Fonts IHoIidays | entree, DOT
General | Documents | System Options | Printers | Database | PricingSetup | GLAccounts |  Scroling Message

Accounting System
System Version m H

AP Release #
Address 1 168 BOSTON POSTRD entrée

Year End Linked Accounting

Generic

Company Information |Delivery Address | Miscellaneous I Diesktop Logc|

Company Madison Distribution

Address 2
City MADISOM

State cT ZIp 06443 Country Code US
contact  CHRIS ANATRA

Phone (203) 245-3339 Fax (203) 245-4513 Bounced Chedk Fee

Fuel Surcharge
[C] Enable faxing Auto Logoff Delay (minutes)

Catchweight +/- percent

3. Click OK to save the new accounting system. Now the “File Moved” message box may display saying
that the Vendor file has been relocated to the proper directory. Click OK.

4. You will then see the “Path Information Changed” message box noting that the data paths have been
changed. Click OK.

5. Restart your entrée system.

6‘ NOTE: One or more path settings have been changed.
E

Any other option settings that have been changed will NOT be
saved at this time.

If you need to make changes to other option settings please
retum here after the corrected path information has been saved.

For security reasons, you will be asked to log into the entrée
application again.

@Nnte . , .
After you complete this step users can use the entrée system again.
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Second, Setup Access to entrée.OB for User Accounts

All users of the entrée.QB application must be granted access in their entrée user account. If one or more of
the operators of entrée.QB does not already have an user account in entrée, you will need to create one for
them now.

E Hot Tlp! Detailed instructions on how to create entrée user accounts can be found in the entrée
KnowledgeBases using the links found in the Getting Started chapter.

Perform the following steps for only users that will be authorized to use the entrée.QB
application.

1. Open the Security Management utility in entrée use menu path:

entrée V3 use menu path: System > Security Management

entrée V4 SQL Go to the System ribbon menu >

2. Select the entrée user to grant access to and click Edit. This will open the user account properties dialog.

3. Click Settings.

entrée V3 & Properties of the SALLY user account l ‘:'_l_‘_J_s:h
. 2l General @)Grou B %@S i = Print
4. Go to the Miscellaneous e 1 Seltings G

system options list.

49 Change Route/Stop information in lnvoicing -
51: Dizplay Special Price tabz in Cugtomer and Inventory Maintenance

55 Allow editing of credit card papment gateway zettingz

56: Dizable editing of the Inventory tab in Inventore File Maintenance

B2 Allow uzer bo view item images in [rvoicing

B3 Allow editing of customer notes from Cugtomer Account Inguin

5. Click the box and check #86
"Allow use of the entrée
Account Linker application”

option. B4 Allow editing of customer notes from Cazh Receipts and Cash Refund
BE: Allow creation of invoices on gcheduled non-work, days
6. Click OK. 70 Edit Open Creditz in Customer File Maintenance

71; Aillow Bage Cost bo be seen when "Hide cost information in File Mainte
77 Allow batch email of invoices to any email addrezs

73 Allow batch email of invoices without providing a customer number

83; Allow uger to zee baze cost on reports, when Hide cost information on

7. Process the rest of the user
accounts that require this
access following the steps
here.

a the ent ant Linker application

a7 Require Packer Info to be entered prior to printing an invoice

91: Allow viesing/zcanning of Customer Credit Applications

93 Allow accessz to Apply Credit/Tizcount in Cazh Receipts

94 Allow uzer to edit Special Real/Baze costz when editing special prices
99 Allow access to the Dot Management Sales Review utiliy

100 Allow access to the Electronic W arshouze Manager module. =

8. When done click Exit to close
Security Management.

D0NRNO0NO000NNEERO00EE

4 e 3

[ Show uger's "Authorized" options

Copy... 4 OF | X Cancel ‘
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entrée V4 SQL L} Properties of the JOE user account l_l_‘_]‘:' ot S
. ) 1 | General ) Groups A Print
4. Select either the Ribbon or
Legacy layout view. Layout | Ribbon || Legscy |
. - O 56 Dizable editing of the Inventory tab in lnventory File Maintenance -
5. Gotothe |V.|ISC€|.| aneous - [ B2 Allow uger to view tem images in Invoicing
system options list. - 63 Allow editing of customer notes from Customer Account |nguin
- i B4 Allow editing of cugtomer notes from Cash Receipts and Cash Fefund
6. Click the box and check #86 - [ BE; .t’-‘n.lll?w creation ':,'f ir.wcuices an sc.heduh.ad nor-work, days
"All f the entrée - 70 Edit Open Credits in Customer File Maintenance
ow USG. 0 . . - O 71: Allow Base Cost to be zeen when "Hide cost information in File M ainte
Account Linker application -0 77 &llaws batch email of invoices to any email address
option_ - O 78 Allow batch email of imvoices without providing a custormer number

- O &3 Allow uzer to gee base cost on reportz, when Hide cost information on
|- O 86 Allows use of the entree Account Linker application |

7. Click OK. - O &Y. Reguire Packer Info to be entered priar to printing an invoice
- B 93 Allow access to Apply Credit/Dizcount in Cazh Receipts
8. Process the rest of the user - [ 94 Allow uzer to edit Special Real/Base costs when editing special prices
accounts that require this - O 100; &llow access to the Electionic Warehouse Manager module.

followi th t - O 103 [Electronic W arehouse Manager] Can authorize manual item substitut
access lollowing the steps - O 104: [Electronic Warehouse Manager] Can autharize manual entry for item
here. - [ 108; Require authentication when assigning scheduler tasks to another ug

- O 107 &llows creation of "Local Default” search configurations
9. When done click Exit to close - [ 108: Allow creation of personal search configurations E
' S ity M t - [ 109; Allow editing of Bid Prices
ecurity Management. - [ 110 Allow use of entréeChat service
4 fr I

Show uzer's "Authorized" optiohs

Copy... [ of OK l | A Cancel

What's Next
The next part of the installation process for entrée.QB is detailed in the First Run chapter. This chapter will

explain the processes required for you to set up access to both systems, and synchronize your entrée and
QuickBooks applications and files. Most of these steps will only have to be done for the first time you run the
application. There is information provided so you can maintain your data going forward. During this process you
will be verifying the data and resolving any errors you encounter. This process will involve fixing account number
conwersion errors, adding or removing accounts in one system or the other etc... These are the steps in the
next phase:

1. Add Application Access

2. GL Account Synchronization

3. GL Department Account Number Conversion

4. Verification of the Chart of Accounts in entrée

5. Verification of entrée Inventory Cost / Price

6. Verification of entrée Vendor Accounts

7. Vendor Account Synchronization
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Your First Run of entrée.QB
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Your First Run of entrée.QB

QuickBooks Application Access

The first time you run entrée.QB you will need to authorize the application in QuickBooks. This is a security
measure enforced by QuickBooks to prevent other applications from accessing or modifying sensitive
accounting data without your consent.

How to Add Application Access

1

2.

Start QuickBooks.

Open the company file in QuickBooks
that you wish to post entrée data into.

Start the entrée.QB application.

QuickBooks

At the login screen, enter your entrée username and password.

The QuickBooks Application with No Certificate dialog box will display. Because the application is
attempting to access the open company file without a certificate. It is strongly recommended that you
select "Yes, whenever this QB company file isopen”.

QuickBooks - Application with No Certificate : |

An application without a certificate ts reguestng access ta the
follorwing QuickBeoks company file:
Food Distribution Company
Accese may incude reading and madifying QuidSocks data as vwel as
enhancing the QuickBooks user interface,
The Applcation Cals Itealf
entrée.(B Accounting Linker

Certificate Information
This application does not have a certificate. QuickBooks
canmot werify the developer's identity.

QuickBooks Solutons Marketplace

Search for information about this application at the
4 QuickBoaks Seluban: Marks iplacs

Do you want ko allow this application to read and modify this company Rle?
i Ne
") Yes, prompt each tme

1 Yes, aways; dlow access even i QuidBooks is not running

| Alew this application o access personal data sudh 22 Social Security Numbers and
' customer credit card information. Tell me mare

[acontouen. | [Locmed ] [Looneo. )

You can however, choose "Yes, prompt each time", but it is nhot recommended as the operator will have
to do this step for each QuickBooks session when entrée.QB accesses the company file for the first time.

6. Once you hawve selected the access type, click Continue.
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7. The Confirm to Proceed dialog box will display to confirm your selection, click Yes.

Conin o proceed S |

g, This applcation is not sigred with a digital certificate.  1F you allow unsigned appicatons to
access your fie, a different application could use the same applcation name and possibly
misise your data. For suggestions about enhancng the safety of your company's data, dick
Help.

Are you sure you want o allow this aocess?

Cel) ([wtes) (i)

8. Then the Access Confirmation dialog box will display click Done.

You have chosen to grant the application
entrée.QB Accounting Linker

access to the QuickBooks company file
Food Distribution Company

whenever this QuickBooks file iz open,

Access rights:
- Read and modify QuickBooks data
(NOT induding persanal data)
-Enhance the QuickBooks user interface

9. Finally, you should receive a message from entrée.QB that the connection to QuickBooks has been
established. Click OK.

Note
@ If you are posting into more than one QuickBooks company, you will need to do the following
for each additional QuickBooks company that you will be posting to:

e Close entrée.QB.
e Close the open company file in QuickBooks.
e Repeat the above procedures, beginning at step 2.
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How To View / Remove Application Access

When you need to view or remowve applications that have access to the open QuickBooks company file
following these steps:

1. From the QuickBooks main menu select Edit > Preferences.
2. Inthe menu bar on the left, select Integrated Applications.

3. Select the Company Preferences tab at the top of the dialog.

My Preferences u Company PI'EI:EJ'!:I'IL‘.I'_"’-J

Yaouw can manage all applications that interact with this QuickBooks company file
here.

[ Dot sliow any sppicabons to sccess this company fie]
[] otify the user before runring any apphcation whose certificate has expred
Applicatiors that have previously requested acoess to this company file

Allow Access  Application |

= Jobs & Estimates

I#g Multiple Currencies
E—ﬂ Payrol & Employees
?@ Reminders

il Reports & Graphs
T sales & Customers
5] =alesTax

'1 Send Forms

Q@ service Connection To learn more about appications that integrate with QuickBooks, go to the
@ speling : Qui g

[ Tax: 1059

] Time & Expenses
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7.2

GL Account Synchronization

This section will outline how to synchronize GL Accounts between entrée and QuickBooks. Typically GL
accounts are pulled into entrée from QuickBooks using the Import GL Accounts utility. However as part of the
initial setup of entrée.QB, operators are allowed to export an existing entrée GL account file into
QuickBooks.

Importing GL Accounts

Internally, entrée has a GL Accounts file that is used mostly for system GL account searches. The data
contained in this look up file, is imported directly from the QuickBooks system using the Import GL Accounts
utility.

Note
E Your QuickBooks GL Accounts must be imported into entrée before any payables or AR journal
entries can be posted into QuickBooks.

g cniresCE Accouning Linker
. fie Post Help
| Import GL Accounts | ] Revean
[EgnT? AcCHETD & Accoml Nane Accou Type DEscempmm Exeznsd 1D Active? | Parenr Acosi
I-IE_____
i - Cazhn Banks (Uzny s CRacking Bank SO0 2TEI24T0 o A
o 11030 Accaunts Recababla Erriranis Recifeazia EN0DMIT-12TETE2418 o 1
¥ 11025 Cash on Hand Dfher Cument Assed SONMZE-12TETER412 &l
IR R Fo Warkpta s Gemnlisa Lot Cunant g e W00 2E-12TEM 241 ¥
o 1040 Adwwania for Doubdl Socoumt O S TS B E0M02E-1275782418 ]
o 1105 Iy (Finished Gaods) CEher Cument Assel SO0MZ-12TETEZ410 o
& 11051- niiiny (WG i Piagedsa) L LTV B 2812 TE0 242 )
o 11052 HMosesioci irrsmiany - Miscella O e Cu g Ass et E0D02E-1XTETERAZR Ca
o 11052 Imwentony Adu=iment Cehes Cument Assed SONHET-1ZTOTC4Z )
7 LELTG Fgd SE5ais - Dle Areousl Fiapd &ga B0 20-12TE TR 2405 ¥
o 13005 Fioed Assats « dooumilabed Deg Finpd Asset S0DIO2EATTETERA2T Ca
o 1an1g- Oice Fusnitune ang Eguipmenl Fapd aze] SO ZF-12TETE4ZR )
¥ 18015- Office FiriluraiE quipmeni-So Fiapd &za01 SN0 S0 1ITETALAI0 o
o 13023 Warchauss Equipmenl Finpd Asset E0D031-12TETa 2431 ta
o Tz~ Wiarehguss Equpmenl - Attum D Fiagsd sade] Lo e e PR T FE s |
o 105 Wehicles Flaged dagel SO0DME-1ITETERIS o
o 18035 Vehicles - Soosmulaled Deprac Finpd Asset E0D0034-12TLTER43G C
AN I [T Comguler Equpment Fingd faau 00 12TEI 2T ¥
s 18045 Corguiar Equipment - Scoum. De Fuaed dsgel SN0 12TETER430 o —
[ & Sclact A ] _u Eﬁlmﬂmn. I [mpoet
I Food D trizuion Comgany
Grid Column Description
Import? This column indicates if the account data will be imported from QuickBooks.
Account # The numeric ID used as an identifier for the GL account.
Account Name Descriptive name for the GL account. Must be 30 characters or less
Account Type The type of account as defined in QuickBooks.
Description The account description (assigned in QuickBooks).
External ID The internal ID assigned to the GL account by QuickBooks. entrée.QB requires
this code to ensure the account is a valid QuickBooks GL account.
Active? Indicates if the account is available to post into.
Parent Account When using departments or sub-accounts, this column will contain the name of the
parent GL account.




Your First Run of entrée.QB 35

How to Use the Import GL Account Utility
1. Inentrée.QB use menu path: File > GL Accounts > Import

2. Select the accounts you want to import into entrée, (all are selected by default).

e Accounts that should be imported will need to be checked in the "Import?" column.
e The checked state of an account can be toggled by...

= Double clicking the line with the account to import in the grid.

= Pressing the "Enter" or "Space" key will toggle the selected row.

= All accounts will be checked by clicking the "Select All" button.

= All accounts will be unchecked by clicking the "Select None" button.

3. Once the accounts to import have been selected, click Import.

4. You may be presented with a Confirm dialog box with a warning that new accounts will be created in
entrée. This is just an informational message.

5. Click OK to continue.

. . One or more of the GL Accounts selected to be imported are not Enked
o an entrée GL Account. These GL Accounts will be created
in the entrie system by clicking the "0R" biftton,

Proceed?

¢ During the import process, the account grid will be hidden and replaced with a message stating “Importing
data...Please wait".

¢ You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

| B selecran | (O SelectNone |

EEEEEEERER Processing account Consuling Senices - General

6. Upon completion the Export Status dialog box will display the number of accounts that were imported into
entrée.

[ieasmi w [

ol 101 accounts were imported.
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7.3

Exporting GL Accounts from entrée

If you are a distributor that has been using the entrée.AP and entrée.GL add-on modules and are moving to
QuickBooks, and have not setup a chart of accounts in QuickBooks yet, you can export the GL accounts that

were used in entrée directly into QuickBooks.

- ertnbeQ Accaurting Linker
Ble Post Help

Export GL Accounts

[ ' Refrash

| -
11011-
11 0
1102
1103

1Mo
111
1103
1102
103

HEE A

wmm Algwanes e Do ceourt——| 0 oo Gomertrezet | B |

<]

S0 IS
1081- 1051
183 R (=8
110653 11053
15000 15000
10 1800
1010 15010
18015 A S
12080
1SR
1800
15035
180

iz
I
|Cd
|
I3
¥
v
[+
IEi
£
[+
&
o

g Sakd gl | [0 Sesecibona |

Expori? AccountZ New Acci#  Account Name

AR in Banks [Spstam Chaceing)
Ciashi in Banks [Manual Checking)
oz on Hand

Marizlable Secunbes

Acegiinls Recakasla

Inamiory (Finished Gosds]
Imeeriary (W ok in Progress)
Fon-shoci inmantony - Miscelanaous
I ity AduEImEn

Flsed Assats « Detault Acoount

Fimgd Azgels - Aoourniats d Depfec.
Office Furniture and Equipment
Office FumniunsEquignvent-2oom De
Warehouse Equipment

Warehilise EqUEent - Ascum, Dsgres

wehides
Wahidas - Acosmulated Depreciaton
Zaenputer Equipensnt

Mew Acct Name

b in Banks [Systerm Checking
Ciash in Banis [Manual Chicking
Cezah on Hand

Markelabie Securies

Aceniinls Recakakla

Imeamiony IFinighed Goods)
Imeemiany (A Ik in Pragress)
hom-shock imvantony - Miscela
Iivepfitary AuEIn el

Fiied Assats « Detaul Account
Fiegd Asgals - Accuemiatad Dep
Cifice Furniture and Equipment
Cffice FurniuneE o presnt-og
Warehouse Equipment
Warehbuss Equigment - Apcum O
Wehides

vahidas - soourmuated Degvec
Caenputer Equipeient

Balance

Accomt Type
.00 Bank
0.00 Bani
(.00 Dther Cument ssse
0.00 Cther Cument Assct
0,00 Acciunts Receanla

.00 Dthar Cument SaEe
(.00 Cther Cumrent Azse
0.00 Cthar Cumend 55581
0,00 Ciher Cuménd szge
0.0D Freed Assal
0.00 Fieed Azgal
0.00 Foed Assal
.00 Fiepd Assat
0.00 Fised Assel
0.00 Fieed Azzal
(.00 Ficed Azzel
0.0D Fieed Assal
.00 Ficgd Agasl

X Bt

#
&
&
&
&
o+
&
i
+
&
&
&
+

<
|
el
¥
el

Acthe?
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Grid Column Description Can Edit

Export? This column indicates if the account data will be exported into

QuickBooks. ]
Account # The numeric ID that was used as an identifier for the GLaccount in entrée.
New Acct # The account number that will be used when the accountis created in

QuickBooks. |
Account Name Descriptive name for the GLaccount that was used in entrée.
New Acct Name The descriptive name for the account that will be used in QuickBooks. This

mustbe 30 characters or less. |
Balance The current account balance of the entrée GL account. This will be the

starting balance of the new QuickBooks account.
Account Type The QuickBooks account type that should be assigned to the entrée

account. |

Active?

Indicates if the accountis available to postinto.

Parent Account

When using departments or sub-accounts, this column will contain the
name of the parent GLaccount.
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How to Use the Export GL Accounts Utility

1. Inentrée.QB use menu path: File > GL Accounts > Export

2. When the Export GL Accounts utility is first opened, you will be prompted to select the entrée GL

account file (GLACNTxx) that you wish to export into QuickBooks.

37

As part of the export process, all accounts that are exported are automatically imported for use in entrée
as part of the process, so you will not need to run an import operation after exporting accounts.

3. Nawigate to the directory that contains the entrée GL account file,

4. Click Open.

5. entrée.QB will then start loading the GL accounts into the account grid.

Files of type

Loak in | i GL

Marme
DBF File (77

[rate miodified

Type

i & GLACMTOL.DEF

6,/6/2010 617 P

DBF File

& GLTYPEOL.DBF
& GLDEPTOL.DEF
= GLEMNTROL.DBF
| GLENTUOL.DBF
i GLRECRO1.DBF
i5 GLYENTOL.DBF

5/36/2000 2:01 PM
572472010 4:37 PM
3/2472010 4:37 PM
3/2472010 4:37 PM
542472010 4:37 PM
5/3372000 9:37 AM

DBF File
DBF File
DBF File
DBF File
DBF File
DBF File

Filz name:

|GLACNTD! DEF

| DBF fles (*.cbf)

e This process may take a little time, so a progress indicator will be displayed in the lower left corner of the
entrée.QB application window.

B Selecl All

O Select Mone

Loading acoournt S0270-300 - Meals - Z&M

Note
@ If you select the wrong file or wish to start over click the Refresh button to reopen the "Select GL

Account file to export dialog.
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GL Department Account Number Conversion

If you were using GL Departments in the entrée accounting system, all of the existing GL account numbers
will have to be reassigned. This is because entrée GL account numbers when departments are enabled are 9
characters in length (##H#HH-###). QuickBooks will only support account numbers up to 7 characters in length.
To help compensate for this during your company transition entrée.QB will attempt to convert your existing
account numbers into a 7 character format using one of several options detailed below.

When departments are detected when exporting entrée GL accounts you will be prompted for the
desired conversion method.

1. Select the desired method by clicking the arrow to view the drop down menu.

Departments detected...

Hecause you are exporing data from an L account file that was used with departmeanis, you will
nesd to select a comeersion mathod. The maximum number of characters that can be used with
CGuickBooks account numbers is (7).

It iz imporant o nate that most corversion methods will remove the dash from the account
number, alang with (1) addiional character of your choosing.

LU=l T I R esequence the depariments using a dash and (1) digit =

. Continue Cancel |

Conversion M ethod Description

Drop the last character of the department |[The dash character and the last character of the department number
will be removed from the account number.

Drop the first character of the department |[The dash character and the first character of the department number
will be removed from the account number.

Drop the last character of the account The dash character and the last character of the account number will
be removed from the account number.

Re-sequence departments using (2) digits || The dash character will be removed from the account. Departments
will be reassigned using two digits starting with "01".

Re-sequence departments using a dash and|| This is the only automated option where the dash character is

(1) digit Selected by default retained. Departments will be reassigned using a single digit starting
with "1".
Manual All new account numbers will have to be manually entered.

2. Select the accounts that you wish to export into QuickBooks, (all valid accounts are
selected by default).

e Accounts that should be exported will need to be checked in the "Export?" column.
e The checked state of an account can be toggled by...

= Double clicking the line with the account to export in the grid.

= Pressing the "Enter" or "Space" key will toggle the selected row.

= All accounts will be checked by clicking the "Select All" button.

= All accounts will be unchecked by clicking the "Select None" button.
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3. Once the accounts to export have been selected, click Export.

4. You will be prompted with a confirmation dialog indicating the QuickBooks company file that you are about
to exchange data with.

5. Click Yes to proceed with the export operation

| About to exchange data with QuickBooks, company [Feod Distribution
| Company].

¢ During the import process, the account grid will be hidden and replaced with a message stating "Importing
data...Please wait".

¢ You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

| @ selectan | O Sslect ane |

BEEREEEERER |Processing account Consulling Senvces - General

6. Upon completion the Export Status dialog box will display the number of accounts that were exported.

Export smm:_i”-«- ===

0 %) account were exported.
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7.5

Verification of Chart of Accounts

After GL accounts have been imported or exported you should \erify the chart of accounts in entrée. You will
update accounts as needed with any new account numbers that may have been created during the
conversion.

¢ You may find that some accounts no longer have a description in the GL Description column. This is typical
if an account number had to be changed when exporting GL accounts.

e Each account you intend to utilize during the AR release process must have both an account number and a
GL Description assigned.

= To edit an assigned account, double click the desired account or press the Enter key to edit the
selected account.

@)
= Double-click the grid line and the Search button will display or hit the F5 key to invoke the
GL Account search screen.

= Ifyou are using Customer GL Link codes, those should be verified or edited as well.

e Once the werification of accounts has been completed click OK.

E Hot Tip! For additional information about the GL Accounts tab use the entrée KnowledgeBase links
found in the Getting Started chapter.

entrée V3 Use menu path: System > Preferences > GL Accounts tab to access and update these

accounts.

ra Y
(;g System Preferences 1 e

Perzonal Settingz ] Company Invoice Headings I Email Setup ] Return Codes ] Corment Fants_| Huolidays ] entree, DOT ]
General ] Diocuments ] Suztem Options I Frinterz ] [1ata Filez ] Pricing Setup GL Accounts l Scrolling Meszage ]
Account Account Number |GL Description -
Accounts Receivable
Irvventan 1 11080- Inwentorg [Finizhed Goods)
Irventan 2 11051- Irwentorg Mwork, in Progress) l
Irventan 3 11052- Mon-ztock Inventony - Migcellansous
Irvventan 4
Irventam &
Irventan B
Iventor 7 i
| ™ ’

Edit Cuztomer Link Codes ‘

—
<
ﬁ
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entrée V4 SQL Go to the System ribbon menu > System Preferences > GL Accounts tab.

-

Accounts Receivable

Inventory 1

Inventory 2

Inventory 3

Inventory 4

Inventory 5

Inventory &

Inventory 7

Inventory 8

01300- INVEMTORY

Edit Cuzstorner Link Codes ]

== System Preferences ==
Perzonal Settings I Company |nvaice Headings | Email Setup | Return Codes I Camment Fants I Halidays
General D acuments I System Options Frinters | Databasze I Fricing Setup | GL Accounts | Scralling Message
Account Account Mumber |GL Description

[m] »
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7.6

Verification of entrée Inventory Cost/ Price

If there are any items that have been assigned override Sales and Cost of Goods Sold GL accounts, those will
need to be verified as well. This is done on the Cost/Price tab of Inventory File Maintenance.

¢ Blank values in these accounts indicate they will use the “Sales Account 1” and the “Cost of Sales 1”
accounts as defined on the GL Tab in System Preferences.

&)
e Use the Search Tool ‘_“‘| to find the specific accounts for the item if needed.

¢ Once changes are made click Apply then OK.

E Hot Tip! For additional information about the Cost/Price tab use the entrée KnowledgeBase links
found in the Getting Started chapter.

entrée V3 Use menu path: File > Inventory Maintenance > locate the item > click the Cost/Price Tab >
GI/L Cost of Sales Account and G/L Sales Account.

(;g Inventory File Maintenance l = i
Item Humber 20007 .f d Description |KETEHUP BTL HEINZ Brand Mame |HEINZ ﬂ
Unit of Measure |CASE - Pack Size |24/140Z. Warehouse Loc. |070 Class |CDNDIMENTS ﬂ
S ale Pricing ] Future Pricing ] Break Pricing ] Statug I Mizc 1 I Mizc 2 I MET ]
Irwentary Wendor ] Hiztam I W arehouse I Fromotionz I Food Show Promotions ] Kitz ] Special Pricing ]
Cost/Price Information Urnit Price [% Ower Cost | Margin | =
Tarable [ Edit Tax Codes... LEVEL 1 12.00% 8.9%
Ii I— LEVEL 2 22 6000 | 15,002 15.0%
Real Unit Cost 18.8253 Broken Caze Upcharge 0.00 LEVEL 2 232500 | 17.50% 17.4%
Freight F ate 0.0000 Group Code COWNDMTS LEVEL 4 24.0000 | 20.007% 20.0%
LEVEL & 25,6000 | 25,002 28.0%
Landed Cost 18.8253 M atrix Code PAPER B 27.4000 | 30,003 29.9%
SPICE 7 38,4000 | 5000 R0.0%
Cost Mark-Up 2.0000 X RBetail Price 0.o0 CHEESE & 010z
Base Unit Cost 19.2018 Level 3
Lewel 10
Mir. Seling Price 149.5858 200 | ¢ & %Z| Quick Price Change ‘ Lewvel 11
Lewvel 12
Market Cost 0.0000 GAL Caost of Sales Account |21 00T— 2 Level 13
; ™y Lewvel 14
G/L Sales Account L e
Lewvel 15 -
103 recards
@ ‘ @ | @ ‘ @ | Add lkem ‘ Copy [tem ‘ Drelete lkem ‘ ok LCancel Apply
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entrée V4 SQL Go to the Inventory ribbon menu > Inventory > locate the item > Cost/Price Tab > G/L
Cost of Sales Account and G/L Sales Account.

[rEntory

Real Unit Cost
Freight Rate

Landed Cost

Cost Mark-Up

Base Unit Cost

Min, Seling Price

Market Cost

Ttem Number |15200
GTIN Number
Unit of Measure

Warehouse Loc.

Misc. Codes  ©

‘Cubic Feet
Gallons

Cozt/Price

cing | Future Pricing | B

CostPrice Information

Processing Trim Costs

Trim Yield %
Trim Yield Cost
Trim Credit

¥ Broken Case Upcharge

Group Code
Matrix Code

&s ©% Retail Price

| 06600 | 001 @ $ © %

|f Quick Price Change 1|

G/L Cost of Sales Account I:l ‘&|
G/L Sales Account I:l ‘&|

_

Description TOMATO PUREE X-TRA HEAWY

Pack Size 6/10

S I

UPCCode 01131

Py
Temp Zone Dry r@é'

ISLAUS

Track By [¥] Stock Item STAN
FOOD PRODUCTS
[Minactive [T Allow Oversell

Dashboards

Inventory | Cost/Price | vendor | purchasing | Warehouse | Promotions | Food Show Promotions | Kits | Special Pricing | Sale Pricing | Future Pricing | Break Pricing | status | Misc 1 | Misc2 [ eT |

Cost/Price Information Unit Price |% Over Cost [Margin |
Level 1 SO0 18.00% | 18.0%
—— aroken Case Upch Level 2 28.1900 | 21.00% 21.0% Cost Changed:  02/21/14
Real UnitCost  19.6808 roken Case Upcharge 0,00 ngec: 1= ]
Level 3 27.8400 20.00% | 20.0% Prce Changed: 0220/ By: A
FreihtRate 2,300 Locked GoupCode Level 4 26.2000 15.00% | 15.0%
Level 5 26,2000 15.00% | 15.0%
Landed Cost 22,0208 Matrix Code Level 5 25.3100 12.00% | 12.0%
Level 7 247500 10.00% | 120.0%
Cost Mark-Up 0.2500 @$ 0% Retail Price 0.00 Level 8 24.2100 8.00% 8.0%
Level 3 26.5100 16.00% | 16.0%
Base UnitCost | 22.2708 Level 10| 26,5100 16.00% | 16.0%
e L T (= Level 11
Min. Selling Price 22,2808 001 @§ O% | Quick Price Change Level 12
° evel
™ o.0000] B Level 13| 256000 13.00% | 13.0%
0.0000 | /L Cost of Sales Account E
Market Cost ~ a] level 14 | 25.9000 14.00% | 14.0%
AL Sales Account RETALL 29.6900 25.00% | 25.0%
EE] 3353 of 16073 [I]E] [ Add Item ] [Copy Item ] lDelste ltem] Cancel Apply
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7.7

Verification of entrée Vendor Accounts

You will need to review and verify any vendors that have been assigned a default Def Expense account and/or
default Def Control account. This is done on the Vendor tab of Vendor Maintenance.

A blank value in the Default Control Account field will instruct the system, to use the first “Accounts
Payable” account that is being used in QuickBooks (the one with the lowest account number).

These accounts will be used by default when creating a payable to export into QuickBooks after closing a
purchase order in entrée.

]
e Use the Search Tool u to find the specific accounts for the vendor if needed.

Once changes are made click Apply then OK.

E Hot Tip! For additional information about the Vendor tab use the entrée KnowledgeBase links found
in the Getting Started chapter.

entrée V3 Use menu path: File > Vendor Maintenance > locate the vendor > click the Vendor Tab >

Accounting Defaults section > Def Exp Acct and Def Ctrl Acct.

i —— i — B
2% Vendor File Maintenance =RNCIN X
Vendor Number |CMC10 o) Company |CIF|I:LE MEAT CO., INC) Phone |212/505-6347
g00 g |900/555-5216 FAX |512.f'555-2548
Wendor “ Broker/Motes I Mizcellaneous ] AP Histary AR History ]
Wendor Address Femittance Address
Address 1 |986JFE BLYD Address 1 | 986 JFK BLVD
Address 2 | Address 2 |
City [ROSEWO0D City |ROSEWO0D
State M5 zZIp |34 State M5 zZIp |3948 Copy Yendor Address
TaxlD Contact [SAM Buper [T DAU-N-G+4: [1234567839953
1033 Type - Tile  [SALES Code | -]
Cauntry Type Inactive [ Cust Mo, |FD3627 Edit Hot! Message
Shipia | Foe |
Aceounting Defaults Sales Tawy | 00000 Open Debits 0.00
Def Exp Acct 31200 .r i Payment Disc % 0.000 Terms NET 14 Current Bal E50.00
DefChl deet |——— | | PayDse Day u Creit Lirit 50000 fvail Credi 43350.00
Pricrity 7 :" Met Due day 14 FTL Purch 0.00 Open PO = 0.00
B¥ recaords
| | e | @ | MNew Wendor | Delete ‘ 0K ‘ Cancel | Apply ‘
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entrée V4 SQL Go to the Vendor ribbon menu > Vendors > locate the vendor > click the Vendor Tab > go
to the GL Account sub-tab > Def Exp Acct and Def Ctrl Acct.

[ & GL,."An:n:nuntl U— Monetary Exchange
DefExpAcct | - | 0O, Def Cirl Acct [02000- || 22
1099 Info -

£ Misc,

Interest
Miscellaneous
Other Income

Vendor Number ARCTIC Buyer RD ~ Type INV ~ Contact  Carl Domino Title Sales - Chart, Grid 12 Month Breakdown
Company ARCTIC FISHERIES Phone 716/632-3833 Toll Free 800/973-2588 Jan 14 \q)
Address 965 MARYVALE DR Fax 716/632-3632 Feb 14 1 9
Email ty@arcticfisheries. com;dan @arcticfisheries.com Mar 14 W =

Apr 14 |£
BUFFALO v NY w 14225 v  Website L2 ﬂ)

$0 £200 $400 $600 800
- i - - TImage Not Defined
Account # Country UsA Ship Via FOB 100 4300 500 &700 2900 il RightClick for Option

MiscCode XX ~v Inactve[ | Comment

& vendor | B purchasing | i ttems | % Maps|

%, Remittznce | B, Broker Address £\ Accountng | 9 Payments & GL/account | 70 Monetary Exchange | @) Miscellaneous|
Address 965 MARYVALE DR Payment Terms  NET 21 -~ Priority Tax D DUNS +4
NetDueDays  21/%) Disc.Days  0/%] CreditLimit 10,000/ % Def Exp Acct 01300~ DefCir Acct | -
BUFFALO - NV v 14225 - Payment Disc % 0.000 Sales Tax % 0.0000 weme [
Invoice Inv Date Due Date PO Number Current Over 21

1] Copy Vendor Address

& HotMessage | [ notes [ /i Specal Instructions [ = P Notes

<No data to display >

Last Invoice 107635 on 11/02/12 for £7,343.00

Last Payment 24413 on 11/23/12 for §7,349,00

Mirimum message display time (seconds) 0% OpenPO's $87L63  MID Purchases $87L63
Totals 0.00 0.00

Open Debits $0.00 Balance §0.00

E]E] 46 of 863 E]E]E] [ ad ][ copy | [ pelete | [ 19 contacts | (1] Dashboards oy | [ ok | [ gose |
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7.8

Vendor Account Synchronization

This section will outline how to synchronize vendors between entrée and QuickBooks. Typically vendor

accounts in entrée are linked into the corresponding vendor accounts in QuickBooks using the Link Vendors
utility. However as part of the initial setup of entrée.QB, operators are allowed to export any vendors in entrée
into QuickBooks or import QuickBooks vendors into entrée.

For additional information about Vendors see the Vendor File Maintenance in your entrée System Guide.
Linking Vendor Accounts

For most installations entrée and QuickBooks each have a vendor file, which is being maintained separately
within each system. The Link Vendors utility will import and store the internal QuickBooks vendor ID directly

within the existing entrée vendor file.

Once your vendors have been linked together, for ongoing maintenance of Vendor accounts you have two

options:

e Import Vendors utility, which will refresh the entrée vendor file with data from QuickBooks.

e Export Vendors utility which will refresh the Vendor name and address properties within QuickBooks
with the export data from entrée.

E entrée.0B Accounting Linker
File Post Hep
Link Vendors || Retash
| emrés ID  Compamy External Company Externzl ID =
[TADID  ANTHONY DAMDSHIGHLAND CO.  ANTHONY DAVIDS HIGHLAMD CO.  BOOD0O0T1-1Z77 144163
| apcie  smcPRmECUTE ABE PRIME CUTS HO00O0Z12TT 148178
BPS10  EILLYSPAPER SUPPLY BILLY'S PAPER SUPPLY BOD00003-1277 144173
CATID  CATCHTHIS
| 'crete cENTURY FOCD CORP.
[ jomcin  cRcLE meEaT coLme CIRGLE MEAT GO, NG BODCD0T-1Z77 144174
| om0 DEVRC FODOS INC. DEVRO FOODS INC. B0D00008-1277 144174
] EPHD EALGLE PACKERS, IHNC EAGLE FACKERS. ING AO000ONR- 1277148174
| 'FFTI0 FARMFRESH TOMATOES FARNFRESH TOMATOES 0D0000A-1277 144174
'._GH':'ID GOURMET EXFRESE GOURKET EXFRESS BO00000B-127TT1441 78
| lgrmo sREsTFOCDS GREAT FOCOS BOO00D0C-127 7144175
| @Ha0 GUNTER FARKS, NG, GUINTER FARMS, INC. B0000O0D-1ZFT 144175
| (6Fs510  GRAMDE FOOD SERVICE GRANDE FOOD SERVICE BOODOD0E-12TT 144175
GRWID  GARDEN FRESH WHOLESALE GARDEN FRESH WHOLESALE B0D0000F-1277 144175
| [GmTi0  cEREERMEATS GERBER MEATS BOODGDID-1ZT7 144175
| HEHD HENSY EROTHERS, INC. HEMRY BROTHERS. INC. B0000011-1277 144176
(] o IMNTERMATIGMNAL MEATS, NG HMTERHATIGMAL MEATS, NG AoanE0AZ- 1277148175
| laFetn JIFFYCHEESECOL MC. AFFY CHEESE CO. INC. 00000131277 144175
] HZS10 K& CSUPPLY WaREHOUSE K& C SUPPLY WAREHOLFSE AOI000 4= 12T I 148175 -
[ @ A0 Link

Madizon Distribuson
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" 1Note

Your entrée vendors must be linked or exported into QuickBooks before any purchase order
payables can be posted into QuickBooks.

Grid Column Description Can Edit
entrée ID This column will display the vendor ID as defined in entrée.
Company This column will display the vendor's company name as defined in entree.
External Company This column will display the vendor's company name as defined in
QuickBooks.
External ID The internal ID assigned to the vendor by QuickBooks. entrée.QB requires this o
code to link the entrée vendor to the QuickBooks vendor

Using the Link Vendors Utility
To run the Link Vendors Utility in entrée.QB use menu path: File > Vendors > Link

It is recommended the first time that you use the Link Vendors utility that you take advantage of the Auto Link
feature, by clicking the Auto Link button in the lower right corner of the Link Vendors utility. Auto Link works by
attempting to match the entrée and QuickBooks vendor company names. If a successful match is found, the
vendors will be linked automatically.

Once this process finishes, the Complete dialog Complate o |
box will display how many vendors were able to be
linked automatically.

Manually Linking Vendor Accounts
Manual linking can be used to link a vendor that was not able to be linked with the Auto Link feature. If the
External Company & ID field already contains a value then the vendor is already linked.

1. Select the entrée vendor that you wish to link to a QuickBooks vendor and press the Enter key. This will
place the cursor in the External ID field for the selected vendor.

2. Click the Search button to the right of the External ID field or press the F5 key to open the Vendor
Search screen. This screen will contain all of the vendors that currently exist in QuickBooks.

The Vendor Search screen allows you to search for a QuickBooks vendor by any of the columns in the
search grid except for "Active". To change the field to search on you can click the column heading or
select the column from the drop down list on the left of the search header.

3. Once the desired vendor is selected, press the OK to return to the Link Vendors utility. The vendor will now
be linked and the External Company and External ID fields will contain the correct values from
QuickBooks based on the selected vendor.
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Vendor Accounts Maintenance

e Removing an Existing Vendor Account
You may run into an issue where the wrong QuickBooks vendor got linked to an entrée vendor. Removing the
link between the two vendors is a simple process.

1. Select the entrée vendor that you wish to remowe the link to and press the Enter key.
2. Clear the current value from the External ID field.
3. You will then be prompted for confirmation.

4. Click Yes to disassociate the entrée vendor for the QuickBooks vendor.

Ir"- " ! About to remove the external link for vendor ADH10 - ANTHONY
L9 DAVIDS HIGHLAND CO..

Continue?

Exporting Vendor Accounts
If you are setting up a new QuickBooks company file, you will want to export your existing entrée vendors into
QuickBooks. This will allow for the creation of payables from an entrée purchase order.

You may occasionally want to refresh the vendor name and address data in QuickBooks from the data
contained in the entrée vendor file. Both of these operations are performed with the Export Vendors utility.

Ext, Acct, # |External Company
AMTHONY DAVDS HIGHLAND SO AOHT0 AMTHONY DAVIDE HIGHLARD SO,
ABC FRIME CUTS APCAD ABC PRIME CUTS
BILLYS PAPER SUPPLY BILLY'S PASEE: SLEELY
BRYS0MN CHICKEMN FARMS
CATCH THIS
CEMTURY FOOO CORS
CIRCLE MEAT G0, INC. CIRCLE MEAT C0, INC.
DENVRO FOODS MG, DEVRD FOODS INC.
EAGLE PACKERE. INC EAGLE PACKERS, INC
FARMFRESH TOMATOES FARMFRESH TOMATCES
GOURMET EXFRESS GOURMET EXFRESS
GFOAG GREAT FOODSE GREAT FODOS
GFI10 GUNTER FARME, INC. GUMTER FARME. IMC.
GF51Q GRANDE FOOD SERVICE GRANDE FOO0 SERWICE
GFAMD GARDEN FRESH WHOLESALE GARDEN FRESH WHIOLESALE
GMTID GERBER MEATS GERBER MEATS
HBID HEMRY BROTHERS. IMC. HENRY BROTHERS, MC
M0 BTERMATIONAL MEATE INC. INTERPATICMAL MEATS, IMC
JFCA0 JFFY CHEESE CO., INC. JIFFY CHEESE SO, INC
K510 K& G SUPPFLY WAREHQLUISE K& T SUPPLY WAREHDLISE

A
-
]
il
=l
il
=
|
#
=
|
=
=
=
#
il
|

g

| @ semcan | |0 Selec pons | | 5% Export!

Marison Distrioution |
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Grid Column Description

Export? Place a check in this field if the entrée vendor should be exported into QuickBooks.

entrée ID This column will display the vendor ID as defined in entrée.

Company This column will display the vendor's company name as defined in entree.

External Acct # This column will display the vendor ID as defined in QuickBooks. Typically this is the
same as the entrée vendor ID

External Company This column will display the vendor's company name as defined in QuickBooks.
Typically this is the same as the entrée vendor company name.

e Using the Export Vendors Utility
1. To run the Export Vendors Utility in entrée.QB use menu path: File > Vendors > Export

2. Select the vendors that you wish to export into QuickBooks, (all valid vendors are selected by default).

e Vendors that should be exported will need to be checked in the "Export?" column.
e The checked state of a vendor can be toggled by...

= Double clicking the line with the vendor to export in the grid.

= Pressing the "Enter" or "Space" key will toggle the selected row.

= All vendors will be checked by clicking the "Select All" button.

= All vendors will be unchecked by clicking the "Select None" button.

3. Ifyou are creating a new vendor, a vendor with the same company name as the entrée vendor cannot
already exist in QuickBooks. If entrée.QB detects that a vendor exists in QuickBooks with the same
company name as the vendor you are trying to create, you will be presented with the Invalid Selection error
dialog indicating that these vendors should be linked.

- . i
Irvvaled Selection i i

a Vendor riv ber BRY10 alresdy ssists in QuickBoaks.

You may be asble to link these vendors.

4. Once the vendors to export have been selected, click Export.

5. A Confirm dialog box will display a message indicating the QuickBooks company file that you are about to
exchange data with.

6. Click Yes to continue with the export.

Condimn T et ===

About to exchange data with QuickBeoks, comparry |Food Distrbution
Company].

e bar s T
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@Note o
— This is just an

informational message.

8.

9.

10.

fyou are creating new o ™

vendors in QuickBooks, a
second Confirm dlalog - . ‘One or mare of the vendars selected to be exported are not link=d

. H : to an efternal vendor sccount. These vendors will be crested in
box YV'" @splay_ with a the QuickBoaks by cicking the "0K” button.
warning indicating that |

. ¥ you believe these accounts already exist in the edemal

new vendors will be accounting system, you should click the "Cancel” button to
created in QUiCkBOOkS abaort this export and use the Vendors -> “Link” option instead. l

Proceed?

Click OK to continue.

During the export process, the vendor grid will be hidden and replaced with a message stating “Exporting
data...Please wait”.

You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

| @ selectan | o Saledﬂ-:lne]

BEREER Processing KCS10 - K & C SUPPLY WAREHOUSE

Upon completion, the Export Status Export Status M =5
dialog box will display the number of | '
vendors that were exported.
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Importing Vendor Accounts

If you have vendors that are setup in QuickBooks that do not exist in entrée, and you want to use to generate
payables or hills for those vendors from an entrée purchase order, you will need to first import them into
entrée using the Import Vendors utility.

You can also import vendor company address and balance data from QuickBooks into the entrée data files for
vendors that have already been exported or linked using entrée.QB.

¥ erote Q8 Accoustng Lnker B
Fde Post Help
| Import Vendors & Rettash
Empert? Ext. Acct. & Extemal Compasy enirée [ Compay
| m Jarcio  [scPRMECcLTs  [wroci |mcPRMECUTS
ADHAD ANTHONY OAWVDOE HIGHLAND &0
il BRSA0 BILLYS PAPER SUPPLY BPS0 BILLY S PAPER SUFPLY
j7i) BRY I BARYSOH CHICKEN FARMS BRYID ARYS0N CHICKEH FARMS
o CATI CATCH THIS CATH ZATCH THES
o CFCID CENTURYFOCD CORP. CFC10 CENTURY FOGD CORP.
" CHMCA0 CIRCLE MEAT 00, INC. CHC1T CIRCLE NEAT ©0, INT
< CERD DEVR FOO0E THC, oFin CEVRD PRSI
o ERID EAGLE PACKERS, INC EFID EAGLE PACKERS, NG
i) FFT10 FARWFRESH TOMATOES FFT10 FARMFRESH TONATOES
4 [yl CARDEM FRESH WHOLESALE GFii CARDEN FRESH WHOLESALE
o GEED FOURMET EXPRESS GEXHD GOURMET EXPRES3
o 50 GRAHDE FOCOD SERVIZE GFSA0 GRAMDE FOCO SERVICE
EI GREAT FOCOS GFDI0  GREATFOSOS
i) GEn GLUNTER FARMS, INC GFIn GUNTER FARNS, INC:
s HAl1d HEHNRY EROTHERE, IMC HEi1D HEHRY EROTHERS, ING
o 1D INTERMATIONAL WEATE, INC WD INTERHATICHAL WEATS, INC
" JFCAT JFFY CHEEEE CO, INGC. JFCiD JFFY CHEESE CO, INC.
| @ sseam | O Seiectpons | [ Hmmgor |
I Madison Déstrisuban
Grid Column Description
Import? Place a check in this field if the QuickBooks vendor should be exported into entrée.
External Acct # This column will display the vendor ID as defined in QuickBooks. Typically this is the
same as the entrée vendor ID.
External Company This column will display the vendor's company name as defined in QuickBooks.
Typically this is the same as the entrée vendor company name.
entrée ID This column will display the vendor ID as defined in entrée.
Company This column will display the vendor's company name as defined in entree.

e Using the Import Vendors Utility
1. To run the Import Vendors Utility in entrée.QB use menu path: File > Vendors > Import

2. Select the vendors that you wish to import into QuickBooks, (all valid vendors are selected by default).

¢ Vendors that should be imported will need to be checked in the "Import?" column.
o The checked state of a vendor can be toggled by...

Double clicking the line with the vendor to import in the grid.
Pressing the "Enter” or "Space" key will toggle the selected row.
All vendors will be checked by clicking the "Select All" button.

All vendors will be unchecked by clicking the "Select None" button.
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If you are creating new vendors in entrée, the vendor in QuickBooks, must have an account number
defined.

If a vendor does not have an account number when attempting to create the vendor in entrée, the Import
Error dialog box will display. Click the Retry button to complete the import of any remaining vendors.

Then, go back into QuickBooks and assign account numbers to the vendor(s) that produced the error
message.

Once account number assignment is completed, you will be able to import them into entrée.

[ Impart Error g [

¢ Emors were encountered when attempting to import vendor A
I % QuickBooks Vendor - Vendor account number cannot be blank,

Select Retry to sttempt bo import any remaining vendars or Cancel to
abort importing the remaining vendors.

Cancel

Once the vendors to export have been selected, click Import.

If you are creating new vendors
in entrée, a Confirm dialog

box will dlsplay 5% Oneor more of the vendors selected to be imported are not linked
to an entiée vendor account. These vendors will be

N reated in the entréesystem by clicking the "OK” button.
A warning will say new vendors e mes i

will be created in entrée. This . I you believe these accounts already exist in the entrée
. . . system, you should dlick the "Cancel” button to abort this expont
IS ]USt an informational and wuse the Vendors -> “Link” option instead.

message.
Proceed?

Click OK to continue.

During the import process, the vendor grid will be hidden and replaced with a message stating “Importing
data...Please wait”. You will also notice a progress indicator in the lower left corner of the entrée.QB
application window.

Upon completion, the Export [E— i ]
Status dialog box will display

the number of vendors that were
imported. 1'0- 46 vendors were imported,
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8.1

Payables Introduction

This chapter will outline how to export a payable or QuickBooks bills that were created in entrée after closing
a purchase order.

To use this feature, you must have completed these steps:

1. Synchronization and verification of the entrée and QuickBooks vendor files using the Link Vendors, Export
Vendors and / or Import Vendors utilities.

2. Synchronization and erification of the entrée and QuickBooks GL account files using the Import GL
Accounts and / or Export GL Accounts utilities.

Creating a Payable in entrée

entrée version 3 and V4 SQL offer the ability to create a payable or vendor bill at the time a purchase order
is received in the entrée system. After receiving product from a purchase order the operator will be prompted
to close the purchase order. The process is the same in either version of entrée.

If Yes is chosen and the purchase order is Question 2 =
closed. —

The Question dialog box will open and ask Post
the purchase order to Accounts Payable.

By selecting Yes the "Post payable to external
accounting" dialog will be displayed.

When the Post payable to external accounting dialog box displays key information will already be
populated using data from the purchase order.

e The vendor information will be displayed along the top of the dialog and cannot be modified.
e The PO number field, in the Payable section, will also be filled in and is not able to be edited.
e Finally the Amount field will be pre-populated with the purchase order total. This value however can be

edited if required.

Post payable to external accounting screen details

Invoice # - The first thing the operator must provide is the invoice number from the vendor. This is keyed into
the Invoice # field. Once that value is provided, more fields will be initialized, such as the due date, the control
account, and a single distribution to the vendors default expense account.

Invoice Date - Enter the date of the vendors inwice in this field. The date can be selected from the calendar
control by clicking the down arrow of the Invice Date control or by pressing the down arrow key on the
keyboard when the cursor is in the Invoice Date field.

I 1Note

= When the Invoice Date value is changed, the Due Date will be automatically updated based on
the number of days between the inwice date and the due date.

Due Date - Enter the date that payment should be remitted to the vendor by in this field. The date can be
selected from the calendar control by clicking the down arrow of the Invoice Date control or by pressing the
down arrow key on the keyboard when the cursor is in the Inwice Date field.




Payables Introduction

accounting
Wendat Infeemation

Vendor B: |4DHTD I;"

AHTHONY DAVIDS HIGHLAMD C0,
380 CANTON 5T
ROSWELL, B 20075

203/555-1245
202/5551246

Paypabler

Imwoice [

PO Number: 10040

Rafanance: |

Dz D zbe:

Invaice Date: |0B/Z2710

0722M0 »

—Accouak Information

Teims:

li
Due Days: IE

Def Lol Bct:

Dref. Exp. At |110680-

Amount: 3870
Cul deet: [Z0000- .ﬂ
Batence ToDicvbute |

Irnvenbory (Fntshed Goods)

entrée V4 SQL

L

yas

Post payable to external accounting...

_oEN

Vendor Information

Vendor #: 011

COAST TO COAST

Phone:  347/240-6273
Fa: |-
Payable

Invoce

Invoice Date: |07/22/14 v

Account Information
rems: |
Due Days: EI

Def.Ctrl Acct: I:I
Def, Exp. Acct: l:l

Amount:

PO Number: & DueDate:  |07/22/14 w Cirl Acct: 20000
Reference: | | Balance To Distribute
Distributions:
Account Account Description Amount Reference ~
w
Add | | Delete
Post | | Cancel
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Amount - Enter the amount due from the vendor's inwice in this field. By default, it will contain the purchase
order total.

Control Account — Enter the GL Liability account that should be credited for the amount of the vendor's inwice
in the Ctrl Acct field. This field will default to the entrée vendor's default control account. If the control account
is empty, it is because there is no default control account defined for the vendor, and entrée was unable to find
an account that was flagged as an “Accounts Payable” account in QuickBooks.

I INote
= The control account may be changed or added by keying the value directly into the Ctrl Acct field

—
or using the GL Accounts search screen, which is accessed by clicking the Search button ‘_’ to the right of
the field or pressing the F5 key while the cursor is in the Ctrl Acct field.

Reference — Up to 20 characters reference or memo may be optionally keyed into this field.
The value entered in this field will appear in the Ref. No. field on the QuickBooks bill.

Balance to Distribute - This field will contain the remaining amount of the payable that needs to be
distributed. This value cannot be edited directly, but is derived using the value in the Amount field less the total
of the distributions that have been applied in the distribution grid. This field will be highlight in green when the
balance reaches 0.00, otherwise it will be highlighted in red.

Distributions

Distributions are one or more offsetting transactions that are debited to a GL asset or expense account, the
total of which offset the amount that was posted to the control account.

By default the total of the purchase order (or the Amount field if manually changed) is posted as a distribution
to the vendors default expense account.

Changing the amount of a distribution in the grid:

1. By selecting the distribution and then pressing the Enter key.

2. Enter the desired distribution amount in the Amount field in the distribution grid.

3. Optionally enter a transaction reference into the Reference field of the distribution grid.

Adding a new distribution to the grid:

1. Click Add.

2. The cursor will be placed in the GL Account field of the distribution grid.

3. Enter the account number for the asset or expense account that should be distributed to. Click the
Search button or pressing the F5 key from within this field to open the GL Accounts search screen.

4. Enter the amount of the distribution in the Amount field in the distribution grid.

5. Optionally enter a transaction reference into the Reference field of the distribution grid.

Removing a distribution from the distribution grid:
1. Select the distribution to remove.

2. Click Delete.
3. A Confirm dialog box will be displayed.
4. Click Yes.

Saving modifications to distributions in payables:
1. Once the total of the distributions matches the total of the vendors invoice, click Post to sawe the payable.
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8.2

Canceling a payable:

1. Click Cancel to discard the payable and the vendors inwice will have to be manually created in
QuickBooks.

2. entrée will warn the operator upon clicking the Cancel button that the payable will be discarded.

|

i bk Descard changes?

3. Click the Yes button to proceed with the Cancel operation

Click the No button to save the payable in the state that it is in.

5. Click the Cancel button to return to the Post payables to external accounting dialog without saving the
payable.

&

Posting Payables in QuickBooks

When a payable is created in entrée, it is put into a holding file. entrée.QB is then used to push the payable
from the holding file into QuickBooks. This is done with the Export Payables utility.

Note
@ Before payables can be posted into QuickBooks, entrée vendors must be linked to existing
QuickBooks vendors or exported into QuickBooks. Also, GL accounts must be imported from QuickBooks or
exported into QuickBooks from the entrée.GL accounts file.

| Rewezn
Vendor Name PO# lovesce® Inv. Date | Amount  Due Date | ColAccr Refezence [
ANTHOMY DEVDS HIGHLAND CO. 10040 5297 0EH15MD IHITOT IIMAZ0 200M0-  BACK HAUL FROM TURSA
BILLYS PAPER SUPPLY | oeiisin A2
CAIICH CLEAN CHEMICAL CO 25781 1411880 TSR0 SAMPLE REFERENCE
£ H. GOODMAN & 20N 1ZME4 04190 1250 GOODMAN STUFF
SPICE ISLAND. INC. 10254764 041310 121620 NEW SFICE
TECDY'S FROZEN FOLOS £27844 0418010 DR MV 122458
WISCONSIN CHEESE CO 45753 DEEIAD 1Mo

4]

S HEEE

[

=
=
L]
=
|

=

I EE P ERE EF ]

@ Select Al | O SelectNone &% Expait!
| I

Keadison Disfribution
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Grid Column Description

Export? Place a check in this field if the payable should be exported into QuickBooks.

Vendor # This column will display the vendor ID as defined in entrée.

Vendor Name This column will display the vendor's company name as defined in entrée.

PO # This column will display the entrée purchase order number associated with the
payable.

Invoice # This column will display the vendor's invoice number.

Inv. Date This column will display the vendor's invoice date.

Amount This column will display the total amount due for the payable.

Ctrl Acct This column will display the Accounts Payable GL account that will be credited when
the payableis created.

Reference This column will display the optional reference thatis associated with the payable.

How to Use the Export Payable Utility
1. Inthe entrée.QB menu using menu path: Post > Payables

2. When the Export Payables utility is first opened, all pending payables are loaded into the payable grid.
Payables are validated when they are first loaded to ensure the Vendors exist in QuickBooks, the control
and distribution GL Accounts are valid, and the distributions are in balance with the payable total. This
process may take a little time so a progress bar is displayed in the lower left corner of the entrée.QB
application window.

E Selicl All O Select Mone

BEEEER Validating Payable: [ZE42F3AE-1FAZ-4BEE-A06E-BCEZ0TEFESNT] fai

*1Note ikormation e
= If there are currently no payables |

pending to be exported into QuickBooks, a [
dialog will be displayed indicating there is
nothing to export and the payable grid will be
empty.

ﬂ Theere are currertthy no payables to export.

3. Select the payables that you wish to export into QuickBooks, (all are selected by default).

e Payables that should be exported will need to be checked in the "Export?" column.
e The checked state of a payable can be toggled by...

= Double clicking the line with the payable to export in the grid.

= Pressing the "Enter" or "Space" key will toggle the selected row.

= Allvalid payables will be checked by clicking the "Select All" button.

= All payables will be unchecked by clicking the "Select None" button.

4. Once the payables to export have been selected, click Export.
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A Confirm dialog box will display indicating

the QuickBooks company file that you are

about to EXChange data with. ﬁ Abaut to En:hang: data with QuickBooks, company [Madison

Distribastion].

Click the Yes to proceed with the export

| Continue?
operation.

During the export process, the payables grid will be hidden and replaced with a message stating
“Exporting data...Please wait”.

You will see a progress indicator in the lower left corner of the entrée.QB application window.

[ @ Selactan | (O Selectiona |

1] Processing payable 65723

Upon completion the Export Status dialog box will display the number of payables that were exported.

BportSaus (e

0 7 transactions were exported,
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9.1

AR Journal Entries

This chapter will outline how to export AR Journal Entries that were created in entrée using the Release to GL
utility.

In order to use this feature, you must have first synchronized the entrée and QuickBooks GL account files
using the Import and /or Export GL Accounts utility in entrée.QB.

Posting Journal Entries in QuickBooks

When the entrée Release to GL utility is run, all account postings are saved to a holding file. entrée.QB then
uses the data contained in the holding file to push the journal entries into QuickBooks.

E Hot Tip! For more information on the Release to GL process use the entrée KnowledgeBase links
found in the Getting Started chapter.

The Journal entry grid is displayed on the left side of the Export Journal Entries utility. This grid displays
information about the journal entry as a whole. If you are posting in Detail mode, this grid will contain additional
columns pertaining to the Sales and Receipt transactions.

The Journal Entry Grid in detail mode displays the miscellaneous code from the Miscellaneous tab in
Customer Maintenance in the main entrée system.

Journal entries can be selected by a specific Misc Code for batch exporting. This process will be discussed in
more detail in the instructions below.

W nlrte QB Accounting Linker
File Post Hep ——
Export Journal Entries
IExputt’? Batch Trans. Date | Trans. Type | Inwvoice 7 Cust. # Check # | Misc Code ] =
5 003 4iZEI2010 Sales 100002 EAS10 R dccounts Recenmble
003 AZEL0O0 Sales 100002 DA o 11050~ inventary (Frimary) -ENTE
[ 003 4ZAL010 Sales 100004 GYR1D o 11200 Fugl Surchargs 500
u B 003 4262010 Sales 100008 EXFI0 R R Salas (Frmary) HNA
P 003 423010 Sales THse T = | |50 Costof Goods (Primany) 23178
: [ 003 4262010 Sales 100007 FERD R
P 003 426010 Sales 100008 JOE1D w
003 4262010 Sales 100002 KMo o
001 4262010 Sales 100010 Mo P
[ 003 42B2010 Sales 100011 STID H
BF 003 ASER0N0  Sales 100012 L0 R
|| P no:  amsmotn sales 100013 JOHD o
L 003 4262010 Sales 100014 MKz D
] 003 426010 Sales 100015 KIMAO ]
[ 001 4262010 Sales 100016 TONS0 R
[ 001 A282010 Sales 100017 SPA1D R
[ 003 42AR010 Sales 100012 S0N10 P
; ¥ 003 4262010 Sales 100015 TAT 10 R
Ll B0 a6t Sales 100020 DEV0 R
[ 003 4262010 Sales 100021 GLED R i |' 000
| Select Al || S-elt:lﬂnnu: [ Expari] ]

I Madisan Dis¥ibution
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Grid Column Description M ode
Export? Indicates if the journal entry will be exported into QuickBooks.
Batch Displays the Batch ID assigned by entrée to the journal entry.
Trans Date Displays the journal entry transaction date.
Trans Type Displays the journal entry transaction type (Sales or Receipt). (detail only)
Invoice # Displays the invoice number associated with a Sales journal entry.
(detail only)

Cust # Display the customer number associated with a Sales or Receipt

journal entry. (detail only)
Check # Display the check number associated a Receipt journal entry. (detail only)
Misc Code Displays the customer's miscellaneous code from the Miscellaneous

tab of Customer Maintenance in entrée. (detail only)

Export Journal Entries Detail Grid

The detail grid is displayed on the right side of the Export Journal Entries utility. This grid displays each of the
GL accounts that will be credited or debited as part of the journal entry. Beneath the Amount column the total
of all accounts is displayed and should always be 0.00, which indicates a journal entry is in balance.

Grid Column Description
Account # Displays the GLaccount number, as defined in QuickBooks.
Account Name Displays the GLaccount name, as defined in QuickBooks.
Amount Displays the amount that will be credited or debited into the GL account

entrée.QB allows for journal entries to be posted into QuickBooks in one of two methods.

1.

2.

Summary mode: will post an entire entrée release batch as a single journal entry.

Detail mode: will post a journal entry for each Sales transaction (inwice/credit memo) and cash receipt
within the entrée release batch. While the detailed posting provides much greater traceability in the
general ledger, it comes at the cost of significantly longer data export times.

entrée.QB by default will post journal entries using Summary mode.

How to Export Journal Entries

1.

2.

From entrée.QB menu use menu path: Post > Journal Entries

To post the full detail, click the Detail button in the top right corner of the Export Journal Entries window.
The detail loading process may take a little time, so a progress bar is displayed in the lower left corner of
the Export Journal Entries window, while the transaction are loaded.

Once detail mode is displayed, you can switch back to summary mode by clicking the Summary button in
the top right corner of the Export Journal Entries window.

Whichever method you decide to post journal entries with, it should be the same for every export to provide
proper consistency in the general ledger.
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Information . o]

Ig Note _ _

If there is currently no pending
journal entries to be exported into QuickBooks, a _
dialog will be displayed indicating there is not 0 et b
anything to export and the journal entry grid will
be empty. Click OK.

L

5. Select the batches (summary mode) or transactions (detail mode) that you wish to export into
QuickBooks, (all are selected by default).

e In Detail mode to select transactions by Misc Code:

= Double-click the desired miscellaneous code in the Misc Code column.
= This will initiate the display of a confirmation dialog box indicating the Misc Code value selected.

N

= Click Yes to select only the transactions with that specific customer miscellaneous code.
= Proceed to step 6 below.

e In Summary mode to select batches/transactions to be exported you need to check the Export?

column. The checked state of a batches/transaction can be toggled by...
=  Double clicking the line with the batch/transaction to export in the Journal Entry grid.
= Pressing the "Enter" or "Space" key will toggle the selected row.
= Allvalid batches/transactions will be checked by clicking the "Select All" button.
= All batches/transactions will be unchecked by clicking the "Select None" button.

Note
E It is strongly recommended that all transactions in a single batch are exported together as to not
have partial release data in QuickBooks.
6. Once the batches/transactions to export have been selected, click Export.

7. A Confirm dialog box will display indicating the QuickBooks company file that you are about to exchange
data with. Click Yes to proceed with the export operation.

T

Canfirm—

st

Alrput to exchange data with QuickBeoks, company [Madison
(W' Distribution].

Coantanue?
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8. During the export process, the journal entry and the detail grid will be hidden and replaced with a message
stating “Exporting data...Please wait".

9. You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

Selectal | [ Selectbione |

. .I... -- messmgﬁabm m;3_;|n-,».;.|.;e1.;|u.;| 13 m._.ntgmm -

10. Upon completion the Export Status dialog box will display the number of transactions that were exported.

[(Eor Stato: T =X

e .

Iﬂl 41 transactions were exported.
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Export GL Accounts Utility 36
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Export Payable Utility 57
Export Vendors utility 46
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Introduction 8
Link Vendors Utility 46
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Online Support Information 18
Online Version Update Process 18
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Change a distribution amount 54
Remowe a distribution 54

- E - Product Features 10
Setup Access to entrée.QB for User Accounts

entrée 26

Cancel a Payable in entrée 54 Synchronization of GL Accounts in entrée &

Creating a Payable in entrée 54 QuickBooks 34

entrée & QuickBooks Vendor Account System Requirements 16

synchronization 46

entrée V3 26 _ G _

entrée V4 SQL 26

Export journal entries by Misc Code to
QuickBooks 61

Export journal entries to QuickBooks using information 18
entrée.QB 61

. . , NECS entrée KnowledgeBases links 18
Export Payables to QuickBooks using entrée.QB g
57 GL Accounts

Export Utility in entrée.QB 36

Getting Started
entrée V3 and entrée V4 SQL color coded

GL Accounts Synchronization using Import GL

Account Utility 34 Synchronization of entrée & QuickBooks 34
payables export 54 Verify chart of accounts in entrée System
Post payable to external accounting 54 Preferences 40

Posting AR Journal Entries 61 GL Departments

Account number conwersion from 9 to 7 characters

Set entrée Accounting System for QuickBooks .
up unting >y Qui for QuickBooks 38

26
Setup Access to entrée.QB for User Accounts
26 - | -
Vendor Accounts exporting, importing, removing
46 Inventory
Vendor Default Expense & Control Accounts entrée Sales & Cost of Goods Sold GL accounts
Verification 44 Cost/ Pricetab 42

Verify Sales & Cost of Goods Sold GL accounts
Inventory Cost / Price tab 42

Verify System Preferences GL Accounts tab chart = L -
of accounts 40

entrée.AP Legal Notices 4
Export GL Accounts into QuickBooks 36 License Agreement 4
entrée.GL
Export GL Accounts into QuickBooks 36 - P -
entrée.QB

Conwert account numbers to a 7 character format
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for QuickBooks 38
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